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Pharmacokinetic Case Study Theophylline IV Kinetics 

Theophylline Kinetics Following a Short 
Intravenous Infusion 

 
Prerequisites 
 

The prerequisite for this tutorial is having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II.” 

 
What you will learn in this case study 
 

• How to create a two-compartment model 
• How to obtain initial parameter estimates 
• How to evaluate the “Fit” 
• How to add a third compartment 
• How to compare the results of two different models 
• How to write some noncompartmental parameters. 

 
Data Required 
 

The data file for this case study is 
 

theo.dat 
 
This data file is a text file. The contents of this file are included at the end of this 
case study. 

 
Introduction 
 
This case study will show you how to analyze data that are decaying biexponentially 
following a short infusion of drug into plasma. It will show you how to obtain initial 
estimates for the model parameters. The equations for the noncompartmental model 
parameters will also be written. 
 
Since the 1930’s theophylline has been used as a bronchodilator to treat patients with 
bronchial asthma. Although oral doses are used in ambulatory patients, this drug is often 
administered intravenously as aminophylline to patients with acute attacks of severe 
asthma. Potentially lethal central nervous system toxicity and cardiac arrhythmias have 
occurred when this drug is given by rapid intravenous injection, so current 
recommendations for intravenous are to infuse a 6 mg/kg dose of aminophylline 
(equivalent to 4.8 mg/kg theophylline) over 20 minutes.  
 
In terms of pharmacokinetic analysis, the result of administering theophylline to humans 
by intravenous infusion is that the drug exhibits a two-compartment pattern of 
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distribution in which the central compartment approximates expected values for 
extracellular fluid space. However, when anesthetized dogs were given bolus injections 
of this drug, a three-compartmental model is needed for pharmacokinetic analysis1. The 
central compartment of this model is blood volume and the intercompartmental 
clearances for the peripheral compartments equal the blood flow to these compartments.  
It is likely that the exceptionally rapid distribution of theophylline to the brain and heart 
account for the toxicity that has been encountered when this drug has been injected 
intravenously at too rapid a rate. 
 
Because bronchial asthma affects young women during their child-bearing years, a serial 
pharmacokinetic studies were conducted in a group of pregnant asthmatic women to 
establish what dose modifications might be appropriate for these patients2. The data for 
this exercise were taken from a study that was conducted in one of the women between 
the 36th and the 38th week of her pregnancy. Subtherapeutic doses were administered. 
Even though only a 5-minute infusion time was used, the data were only adequate to 
characterize a two-compartment pharmacokinetic model. 
 
1. Belknap SM, Nelson JE, Ruo TI, Frederiksen MC, Worwag EM, Shin S-G, Atkinson 

AJ Jr: Theophylline distribution kinetics analyzed by reference to simultaneously 
injected urea and inulin. J Pharmacol Exp Ther 1987;243:963-9. 

  
2. Frederiksen MC, Ruo TI, Chow MJ, Atkinson AJ Jr. Theophylline pharmacokinetics 

in pregnancy. Clin Pharmacol Ther 1986;40:321-8. 
 
 
Part 1.  Develop a Two Compartment Model for Theophylline Kinetics. 

The first step will be to investigate the data and postulate a two compartment model to 
describe the data following iv as a short iv infusion.   
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. In the SAAM II Toolbox, be sure the Model tools are 
available. 

 
2.  Investigate the data. 
 

The first step in any new model development process should be to investigate the 
data. This will give you an idea as to how many compartments will be needed. 
For example, if you plot the data following a bolus or short infusion, and in 
semilog mode they appear as a straight line, then a single compartment will 
probably be adequate. If, on the other hand, they appear to decay at least 
biphasically, then at least two compartments will be needed. 
 
a. In the Show menu, click Data, or alternatively, on the SAAM II Toolbar, 

click Data . The Data window will open. 
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b. In the File menu, click Open. The file “theo.dat” should appear in the list (if 
it does not, find the folder where you have put this data file). 

 
c. Double-click theo.dat. The data file contains the plasma theophylline data 

following the 5 minute constant infusion. The plasma data appear in the 
column called “Plasma”. The Data window will appear as follows: 

 

 
 

 
The weighting scheme is FSD so you can leave the variance model set as the 
default data-relative.  

 
d. Close the Data window. 
 

2. View the data using a line plot. 
 

a. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Experiment Attributes dialog box will open. 
 

(1) Enter “360” in the End At box. The Experiment Attributes dialog box 
will appear: 
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(2) Click Done. The Plot and Table Variables dialog box will open. 
 

 Experiment attributes. Normally you are used to seeing the Experiment 
Attributes dialog box when you switch from the Model to Experiment tools. 
In this situation, no model has been created, so SAAM II does not know the 
duration of the experiment. When you try to plot the data, SAAM II must 
know when the experiment ends. For this reason, the Experiment Attributes 
dialog box opens at this point in the case study. 

 
 

b. The List All Variables check box is selected. The reason the box is selected 
is because there are no samples specified yet. 

 
c. Click Plasma to move it to the Current Selection pane. 
 
d. Click Done. A plot of the plasma data will appear in the Plot window. 
 
e. In the View menu, click Line Plot. 
 
f. In the View menu, click Semilog.  
 
g. In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. 
 
h. In the Y Axis pane, click Set. Enter “1” in the Minimum box, and “20” in the 

Maximum box. The Plot and Table Scale dialog box will appear as follows: 
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i. Click Done. The line plot of the data will appear as follows: 
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 Line Plots. Using the line plot in semilog mode to connect the data can help 
you decide how many exponentials (compartments) will be needed for the 
model. In this case, it is clear that at least two exponentials, or compartments, 
will be needed.  

 
 It is also important to note that the first datum, taken at 5 minute, occurs when 

the infusion has just ended. It is possible that mixing may not be complete. 
 
 The break in the curve appears around 40 minutes, so as described in 

Appendix 1, initial estimates for the rate constants of the two compartment 
model will be 0.025. An initial estimate for the volume of compartment 1 can 
be obtained by dividing the total dose by the 5 minute datum. This is 200/15.5 
which is approximately 13. 

 
 More information on obtaining initial parameter estimates for the two 

compartment model is provided in the Appendix 1. 
 

 
j. Close the Plot window. 

 
3. Create the following system model on the Drawing Canvas: 
 

 
 

4. In the SAAM II Toolbox, click Experiment. Notice that the Model tools are 
unavailable and the Experiment tools are available. Notice also the Experiment 
Attributes dialog box does not open. This is because the experimental attributes 
have already been specified. However, the Create Experiment dialog box will 
open. 
 
a. Be sure the Experiment is selected. Type “iv_theophylline” in the New 

Name box. The Create Experiment dialog box will appear as follows: 
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b. Click Create. 
 
5. Create a sample. 

 
a. In the SAAM II Toolbox, click Sample. 
 
b. Click compartment q1, then click on the Drawing Canvas. The sample s1 

will appear. 
 
c. Double-click s1 to open the Sample Attributes dialog box. 
 
d. Type “mcg/ml” in the Units box. 
 

 Units. The units of the data are micrograms/milliliter. Normally this would be 
written μg/ml or μg/mL. SAAM II does not accept μ for micro. Writing the 
units mg/ml would be normally interpreted as micrograms/ml. Thus writing 
the units mcg/ml is a convenient way to denote the microgram. 

 
 
e. Type “Plasma” in the Associate with Data Name box. 
 
f. Edit the sample equation “s1 = q1” to read “s1 = q1/V1”. The Sample 

Attributes dialog box will appear: 
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g. Click Done.   

 
6. Create an input. 

 
An intravenous dose of 200 mg of theophylline was infused over 5 minutes.  
 
a. In the SAAM II Toolbox, click Input 
 
b. Click compartment q1, and then click on the Drawing Canvas. The input ex1 

will appear. 
 
c. Double-click ex1 to open the Exogenous Input dialog box. 
 
d. Select Infusion as the Input Type. 
 
e. Enter “40” in the Constant Rate box. 
 
f. Enter “0” in the Event Start box. 
 
g. Enter “5” in the Event Stop box. 
 
h. Click Add. The Exogenous Input dialog box will appear: 
 

©University of Washington Theo IV - 8 Rev. 08/10/13 



Pharmacokinetic Case Study Theophylline IV Kinetics 

 
i. Click Done. 

 
7. Enter parameter values. 

 
a. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. 
 

The parameter V1 should be selected. If it is not selected, double-click V1. Be 
sure the Adjustable option is selected. 

 
b. Enter “13” in the Value box, “5” in the Low Limit box, “30” in the High 

Limit box, and click Save. 
 

c. Double-click k(0,1) to select it. 
 
d. Enter “0.025” in the Value box, and click Save. 
 
e. Double-click k(2,1) to select it. 
 
f. Enter “0.025” in the Value box, and click Save. 
 
g. Double-click k(1,2) to select it. 
 
h. Enter “0.025” in the Value box, and click Save. 
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When you have finished, the Parameters dialog box should appear as follows: 
 

 
 

i. Click Done. 
 

 Initial parameter estimates. The initial parameter estimates were obtained as 
described in the comments following the line plot shown previously. 

 
 

8. Solve the model and view the solution. 
 

a. In the View menu, select Model Labels, and click Values. 
 

 Label “Values”. In the model, the default name for the transfers is k(i,j). You 
have the option of displaying the numerical values of the parameters. This can 
help you keep track of the modeling exercise. 

 
 

 
b. Set the Minimum Number of Calculation Intervals equal to 500. 
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(1) In the Compute menu, click Settings. The Computational Settings 
dialog box will open. 

 
(2) Enter “500” in the Minimum Number of Calculation Intervals box. The 

Computational Setting dialog box will appear as follows: 
 

 
 

(3) Click Done. 
 
 

 Minimum Number of Calculation Intervals. In order to see the details of the 
model solutions, especially the initial rise during the 5 minute infusion, you 
must set the Maximum Number of Calculation Intervals to a large number 
such as the maximal 500. 
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c. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . The model will appear as follows with the 

parameter names replaced by their numerical values: 

 

  
 
d. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar click 

Plot . The Plot and Table Variables dialog box will open. 
 
e. In the Plot and Tables dialog box, clear the List All Variables check box to 

list only those variables associated with data. 
 
f. Click s1:Plasma; these will move to the Current Selection pane. 
 
g. Click Done. The plot will appear as follows: 
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Notice in the plot that the autoscale option is active in the Plot and Table 
Scale dialog box. Remember you set the Y axis scale when you did the line 
plot. The reason why autoscale is now active is that the model calculated 
values fall below 2, the minimum value set previously for the line plot. 
 
Notice also the details of the rising portion of the curve; if the Minimum 
Number of Calculation Intervals was set at the default value of 20, you 
would not see this rise. 
 
The initial estimates are reasonable, but the value for k(0,1) is obviously too 
large. If you wish, you can try hand-fitting to improve the estimates. For 
example, if you set k(0,1) equal to 0.01, the plot will change as shown below: 
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You may continue to hand-fit if you wish. However, these estimates are close 
enough so that you can fit the model to the data. 
 
Leave the Plot window open. 

 
9. Fit the model to the data and view the solution. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar, 

click Fit . (You may receive a warning about a parameter value reaching a 
limit - if you do, change the appropriate limit, and Re-Fit the model to the 
data).When you have “Fitted” the model to the data, the plot should appear as 
follow (in this plot, the Plot and Table Scale has been adjusted - the Y Axis 
minimum and maximum are respectively 1.5 and 20): 
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Leave the Plot window open. 
 
b. In the Show menu, click Statistics, or alternatively, on the SAAM II 

Toolbar, click Statistics . The Statistics window should appear as 
follows: 
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It is apparent from the Coefficients of Variation in the Statistics window that 
the model parameters are all well defined. The largest coefficient of variation 
is 10%. 
 
Record the values for AIC and BIC; these will be used later to help determine 
whether a two-compartment or three-compartment model is most appropriate 
for these data. 
 
Close the Statistics window. 
 

c. View the weighted residuals (remember the Plot window is still open.) 
 

(1) Click on the Plot window to make it the current window. 
 
(2) In the Set menu, click Plot/Table Variables. The Plot and Table 

Variables dialog box will open. 
 
(3) Select the List All Variables check box. 
 
(4) Click s1_wres. This variable will move to the Current Selection pane. 
 
(5) Click Done. The plot is not informative because the Y-Axis scale was set 

manually, and the plot is semi-log. These need to be changed. 
 
(6) In the View menu, click Semilog to return the plot to a linear plot. 
 
(7) In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. 
 
(8) In the Y Axis pane, select Set. Enter “-1.5” and “1.5” respectively in the 

Minimum and Maximum boxes. The Plot and Table Scale dialog box 
will appear as follows: 
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(9) Click Done. The plot of the weighted residuals will appear as follows: 
 

 
 

While the weighted residuals do line in a band close to -1 and 1, it is clear 
there are systematic deviations in the beginning and mid-part of the curve. 

 
(10) Return your plot to s1:Plasma. You will have to reset the Y Axis scale to 

a minimum and maximum of 1.0 and 20 respectively. 
 

 Runs test. You can if you wish perform the runs-test for goodness-of-fit. How 
to do this is explained in Appendix 2. 

 
 

10. (Optional) Record the results in the Notes window. The contents of the Notes 
window is given in Appendix 3. 
 
a. In the Show menu, click Notes or alternatively, on the SAAM II Toolbar, 

click Notes . The Notes window will open. 
 
b. Type the text “Best fit of the two compartment model to the data.” 
 
c. In the Statistics window, select all the information in the 

Parameter/Variables pane.  
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d. In the Edit menu, click Copy. 
 
e. Click in the Notes window. In the Edit menu, click Paste. Title the columns 

for parameters, values, etc. as shown in the figure below. 
 
f. In the Statistics window, select the information for the objective function. In 

the Edit menu, click Copy. 
 
g. Click in the Notes window. Click below the statistical information. Paste the 

information from the objective function. The Notes window will appear as 
follows: 

 

 
 
Part 2.  Estimate Clearance and Volume Parameters from the Model. 
 
The clearance and volume parameters can calculated directly from the compartmental 
model parameters.  
 

1. Enter the equations for the pharmacokinetic parameters calculated from the model 
parameters. 

 
a. In the Show menu, click Equations, or alternatively, on the SAAM II 

Toolbar, click Equation . The Equations dialog box will open. 
 

b. Enter the following equations in the Equations Defined Here pane in the 
Equations dialog box. 

 
CLe = V1*k(0,1) 
CLi = V1*k(2,1) 
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V2 = CLi/k(1,2) 
Vss = V1+V2 
 
The first two equations are clearance, one from “plasma” Compartment 1 and 
the other from the extravascular Compartment 2. V2 is the “volume” of 
Compartment 2 while Vss is the “steady state” volume, or equivalent volume 
of distribution. 
 
The Equations dialog box will appear as follows: 

 

 
 

c. Close the Equations dialog box. 
 

2. Re-Fit the model to the data. The Fit will not change, but you will obtain 
statistical information on the pharmacokinetic parameters.  

 
a. Open the Statistics window. You can see there is very little difference in the 

parameter values and their error estimates. 
 

 Objective function information. You may notice that the objective function 
information changes a little between the first “Fit”, recorded in the notes, and 
this “Fit”. The reason why this happens is because in the first “Fit”, you 
started from another initial set of parameter estimates than this “Fit” above 
which actually started from a “best Fit”. 
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 SAAM II, as do many other software tools, uses formulas to calculate 
derivatives required in the fitting process. These are approximation, and can 
be somewhat sensitive to the initial starting values. 

 
 Technically, to obtain the most accurate and reproducible parameter values 

and errors, you should fit the model to the data. Then, in the Computational 
Settings window in the Compute menu, select the Central option for the 
Derivative calculation. The central option is more accurate than the default 
forward option, but it takes longer to compute. This is why the forward option 
is set as the default. 

 
 

If you are not copying your results in the Notes window, close the Statistics 
window and proceed to Part 3.  

 
b. (Optional) In the Statistics window, and select and copy the information in 

the Parameter/Variable pane. Close the Statistics window. 
 
c. Open the Notes window, and paste this information over the statistical 

information you had originally on the parameters. The Notes window should 
appear as follows: 

 

 
 

d. Close the Notes window. 
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Part 3.  Add a Third Compartment to the Model 
 
This part of the case study will show you how to add a third compartment to the model. 
 

1. In the SAAM II Toolbox, click Model to make these tools available. 
 
2. Modify the system model on the Drawing canvas as follows: 

 

 
3. In the SAAM II Toolbox, click Experiment. Notice that the Model tools are 

unavailable and the Experiment tools are available. Notice also that the 
Experiment Attributes dialog box does not open. This is because the experiment 
attributes have already been specified. The model will appear as follows (you may 
have to move some of the objects): 

 

 

 Modifying a system model. Suppose you have created the system model, and 
the experiment on the model. That is, you have specified the experiment 
attributes. In addition, if you have edited the data file, the information will 
remain. When you modify the system model by adding more compartments or 
transfers, the experiment attributes do not change. What changes will change 
is the information required to solve the model, or fit the model to the data. 
When you add additional transfers, you must specify the initial values and 
bounds (if they are adjustable). In this above case, you have added a third 
compartment, compartment 3, and two transfers, k(3,1) and k(1,3). Thus to 
solve the model, you need only provide initial estimates and the bounds for 
these parameters. 
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4. Enter the parameter values. 
 

 Obtaining initial parameter estimates. When you build the model structure as 
we are doing in the case study, you need to provide initial estimates for the 
new parameter, in this situation, k(3,1) and k(1,3). You can use the best 
estimates from the two-compartment model as follows to obtain these 
estimates. In the case of the two compartment model, the best estimates are:  
V1 = 10.5, k(0,1) = 0.009, k(2,1) = 0.1 and k(1,2) = 0.034. You now need 
initial estimates for V1, k(2,1), k(1,2), k(3,1), k(1,3) and k(0,1). Let us assume 
Compartment 2 is the rapidly turning over compartment. 

 
i. Initial estimates for k(2,1) and k(1,2). Initial estimates for k(2,1) and k(1,2) 

can be obtained by doubling the average between k(2,1) and k(1,2) from 
the best “Fit” of the two-compartment model. This number is about 0.12. 

 
ii. Initial estimates for k(3,1) and k(1,3). Initial estimates for k(3,1) and k(1,3) 

can be obtained by halving the average between k(2,1) and k(1,2) from the 
best “Fit” of the two-compartment model. This number is about 0.03. 

 
iii. Initial estimates for V1 and k(0,1). Initial estimates for V1 and k(0,1) can 

be obtained by using the best fit values for the two compartment model. 
These are 10.5 and 0.009 respectively. 

 
This rule of thumb in terms of obtaining initial parameter estimates works 
most of the time. When it does not, you may need to hand-fit to adjust some of 
the initial estimates. 

 
 

a. In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. The 
parameter V1 should be selected. If it is not selected, double-click V1. Be sure 
the Adjustable option is selected. 

 
b. Enter “10.5” in the Value box, and click Save. (There is no need to adjust the 

low and high limit.) 
 

c. Double-click k(0,1) to select it. 
 
d. Enter “0.009” in the Value box, and click Save. (There is no need to adjust 

the low and high limit.) 
 
e. Double-click k(2,1) to select it. 
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f. Enter “0.12” in the Value box, and click Save. (There is no need to adjust the 

low and high limit.) 
 
g. Double-click k(1,2) to select it. 
 
h. Enter “0.12” in the Value box, and click Save. (There is no need to adjust the 

low and high limit.) 
 
i. Double-click k(3,1) to select it. 
 
j. Enter “0.03” in the Value box, and click Save.  
 
k. Double-click k(1,3) to select it. 
 
l. Enter “0.03” in the Value box, and click Save. The Parameters dialog box 

will appear as follows: 
 

 
 

m. Click Done. 
 

5. Modify the clearance and volume parameters. 
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 Since you have added a new compartment to the model, you need to modify the 

pharmacokinetic parameter equations as follows: 
 
CLe = V1*k(0,1) 
CLi = V1*k(2,1) 
V2 = CLi/k(1,2) 
CLi2=V1*k(3,1) 
V3=CLi2/k(1,3) 
Vss = V1+V2+V3 
 
Notice the first three equations do not change. The next two are added to 
accommodate the third compartment, and the last to calculate the correct Vss. 
When you have finished, the Equations dialog box will appear as follows: 
 

 
 

 
6. Solve the model and view the solution. 

 
a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
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b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The plot of s1 and Plasma will appear as follows (you will 
probably have to reset the Plot and Table Scale; the following has a Y Axis 
minimum and maximum of 1.0 and 20 respectively): 

 

 
 
The initial parameter estimates are sufficient that we can proceed to fit the 
model to the data. Leave the Plot window open. 

 
7. Fit the model to the data and view the solution. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar, 

click Fit . When you have “Fitted” the model to the data, the plot should 

appear as follows: 
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Leave the Plot window open. 
 

b. In the Show menu, click Statistics, or alternatively, on the SAAM II 

Toolbar, click Statistics . The Statistics window will appear as follows: 
 

 
 

The statistics are not as good as the two-compartment model; the largest 
coefficient of variation is just over 40%. Yet the model predicted values do 
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better than the two-compartment model in describing the kinetics around the 
break in the curve. 
 

 Interpreting the statistics. In interpreting the statistical information in terms of 
the parameter precision, you expect less precision when you add complexity 
to the model. But the question is, besides the primary parameters changing, 
how to the pharmacokinetic parameters change? 

 
 You have seen the biggest change is about a 40% error in k(3,1). In terms of 

the pharmacokinetic parameter, the largest error is in V2; the error in V3 is 
only 15%. Finally the addition of the third compartment had little effect on 
Vss either in terms of the numerical estimate or the parameter precision. 

 
 Notice in this case the values for AIC and BIC are both lower for the three-

compartment model when compared with the two-compartment model 
indicating the three-compartment model is more appropriate. 

 
 
If you are not recording your results in the Notes window, close the Statistics 
window, and proceed to Step 8. 

 
c. (Optional) In the Statistics window, in the Parameter/Variable pane, select 

the parameters and derived variables. 
 
d. In the Edit menu, click Copy. 
 
e. In the Show menu, click Notes, or alternatively on the SAAM II Toolbar 

click Notes .. The Notes window will open. 
 
 f. In the Notes window, type “Best fit of a three-compartment model to the 

data.” 
 
g. In the Edit menu, click Paste. The statistical information will be pasted into 

the Notes window. 
 
h. In the Statistics window, in the Objective pane, select the s1:Plasma 

objective function, and the AIC and BIC criteria. 
 
i. Return to the Notes window. In the Edit menu, click Paste. The last part of 

the Notes window will appear as follows: 
 

©University of Washington Theo IV - 27 Rev. 08/10/13 



Pharmacokinetic Case Study Theophylline IV Kinetics 

 
 

The contents of the Notes window are included as Appendix 3. 
 
j. Close the Notes and Statistics windows. Leave the Plot window open. 

  
8. View the residuals. 
 

a. Click on the Plot window to make it the current window. 
 
b. In the Set menu, click Plot/Table Variables. The Plot and Table Variables 

dialog box will open. 
 
c. Select the List All Variables check box. 
 
d. Click s1_wres. This variable will move to the Current Selection pane. 
 
e. Click Done. The plot is not informative since it is in semi-log mode and the Y 

axis scale has been set for s1 and Plasma. 
 
f. In the View menu, click Semilog to return to a linear plot. It is necessary to 

reset the scale. 
 
g. In the Set menu, click Plot/Table Scale. The Plot and Table Scale dialog 

box will open. 
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h. In the Y Axis pane, select Set. Enter “-2” in the Minimum box, and “2” in the 
Maximum box. The Plot and Table Scale dialog box will appear as follows: 

 

 
 

i. Click Done. The plot of the weighted residuals will appear as follows: 
 

 
 

The residuals have improved considerably with no apparent systematic 
deviation. In addition, they lie in a band almost between -1 and 1 which, for a 
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good fit of the data with the proper weights assigned, is in line with statistical 
theory. 
 

 Which model is best?  You have two pieces of information to determine which 
of the two or three-compartment model is most appropriate to describe the 
these data. First are the residuals. To complete the modeling exercise, you 
should perform a runs test on the residuals (or weighted residuals) of both the 
two and three-compartment models (this is done in Appendix 2). Second is an 
analysis of the parsimony parameters, AIC and BIC. In this case, parsimony 
criteria support the three-compartment model 

 
Finally, to complete the exercise, you should try a four compartment model. If 
you do (following the above rules for obtaining initial parameter estimates), in 
most cases you will have problems fitting with different parameter values 
hitting lower limits. In the event that you choose a set of initial values where 
you actually fit, you fill find that some of the parameters have error estimates 
greater than 100%, and the value for AIC and BIC is larger than for the three 
compartment model. 

 
 

 
You may save the study file if you wish for future use.  
 
Quit the SAAM II Compartmental application. 

 
 
 
Essential Points to Remember 
 

• Pharmacokinetic parameters can be defined as part of the model 
• When necessary, it is easy to add a new compartment to the model. 
• There are convenient ways to obtain initial parameter estimates for the model; 

these include adding model complexity. 
• When adding a compartment to the model, you need to check all the new 

parameter values and their precision including the derived parameters. 
 
Modeling Notes 
 
There is a very important but subtle point to be learned in this case study. That is the drug 
was input as a 5 minute constant infusion, not a bolus. You notice when you plot the data 
you do not see this. The reason is because of the resolution of SAAM II’s plots. The 
resolution of the plots is determined by the Minimum Number of Calculation 
Intervals, a number used by SAAM II to determine when values of the model solution 
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should be saved for plotting or tabular purposes. You previously set this number to its 
maximum value of 500. 
 
Below is the best fit of the three-compartment model to the data. 
 

 
 

If you expand the initial part of the curve: 
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You can clearly see the rising portion of the curve starting from zero! 
 
Yet when the initial parameter estimates were obtained using any of the curve peeling 
methods, a bolus injection was assumed. While incorrect, it did yield sufficiently close 
initial estimates to proceed. 
 
Suppose you ignored the fact that this was an infusion, and treated the input as a bolus. 
To see what happens, this can be simulated by changing the input format from an 
infusion to a bolus. The first part of the curve will appear (comparing solutions): 
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You can see a big difference in the beginning. What is affected? The estimated volume 
V1! When the input is described by the 5 minutes infusion, V1 is estimated to be 9.4L 
while if the input is regarded as a bolus, V1 is estimated to be 6.0L. This is more than 
30% lower, and ALL pharmacokinetic parameters estimated with a volume term will be 
in error by this percentage. 
 
The point is: SAAM II can simulate exactly what was done in the laboratory; there is no 
need to try and do something different! 
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Data for this case study 
 
DATA 
(FSD 0.1) 
t Plasma 
5 15.5 
6 13.8 
7 11.8 
10 9.45 
15 6.43 
20 5.87 
30 4.85 
45 4.24 
60 3.84 
90 3.66 
120 3.40 
150 3.07 
180 2.95 
240 2.52 
300 2.54 
360 2.20  
END 
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Appendix 1: Obtaining Initial Parameter Estimates 
for the Two-Compartment Model (Two-Exponential Model) 

 
The key to understanding how initial parameter estimates can be obtained for the two-
compartment (or two-exponential) model lies in understanding the notion of half-life. The 
half-life is defined as the time it takes for one-half of the material remaining in a system 
to irreversibly leave the system.  
 
In this appendix, it is assumed that you have worked through the appendix explaining 
how to obtain initial parameter estimates for the one-compartment model; this appendix 
follows the case study on cadralazine kinetics. The ideas presented in this appendix 
extend upon those presented for the one-compartment (one-exponential) model. In this 
situation, unlike the one-exponential case, the data following the bolus injection into 
plasma do not appear as a straight line when plotted semilogarithmically. However, as 
will be seen, the biexponential decay is a combination of two monoexponential decays. 
 
In this appendix, you will learn how to obtain the initial estimates in the following two 
situations: 
 
• bolus injection of drug into plasma, and serial plasma samples taken; and 
• constant infusion of drug into plasma, and serial plasma samples taken. 
 
The bolus injection will be discussed first. Three different techniques that can be used to 
obtain initial parameter estimates will be discussed. 
 
To begin, some information concerning the structure of the general two-compartment 
model and sums of exponentials is necessary. The general two-compartment model is 
given below: 

 
Model 1. The general two-compartment model with five parameters. 

 
If the sample equation s1 is given by s1=q1/vol, then there are five parameters in this 
model: vol, k(2,1), k(1,2), k(0,1) and k(0,2). If the input into compartment q1 is a bolus, 
then it is known that the solution to the system of differential equations represented by 
the model is an expression of the form: 
 

 tata eAeA
vol
qts 21

211
1)( −− ⋅+⋅==  (1) 
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while if the input into compartment q1 is a constant infusion, the solution is: 
 

 01)( 2102101
21 =++⋅+⋅+== −− AAAeAeAA

vol
qts tata  (2) 

 
For both sums of exponentials, there are four parameters:  A1, A2, a1 and a2. This is true in 
the case of (2) because of the equation constraining the sum of the parameters equal to 
zero. 
 
It is known2 that for a set of biexponentially decaying (i.e. following a bolus injection) or 
biexponentially rising (i.e. following a constant infusion) that the four parameters of the 
exponential model are unique (called a priori or uniquely identifiable). However, the five 
parameters of the general two-compartment model are not uniquely identifiable. In this 
case, there are an infinite number of solutions. Why is this the case? 
 
The reason why this is the case comes from the relationship between the A1, A2, a1 and a2 
and the vol, k(2,1), k(1,2), k(0,1) and k(0,2). This is important since it provides the 
equations by which the initial parameters for the two-compartment model can be 
obtained. The relationship comes from a priori identifiability analysis [2]. 
 
The relationship for the bolus injection is the following: 
 

 

k(1,1) = A1 ⋅ a1+ A2 ⋅ a2
A1+ A2

k(2,2) =
A2 ⋅ a1+ A1 ⋅ a2

A1 + A2

k(1,2) ⋅ k(2,1) =
A1 ⋅ A1 ⋅ (a1− a2)2

(A1+ A2)2

vol =
d

A1+ A2

 (3)  

 
where k(1,1) = k(2,1)+ k(0,1)  and k(2,2) = k(1,2)+ k(0,2) , and d is the amount in the 
bolus. Thus the parameters that can be uniquely identified as vol, k(1,1), k(2,2) and the 
product k(1,2)k(2,1). The relationship for the k(i,j) is the same for the constant infusion 
experiment; the expression for vol is different as discussed below. 
 
If the general two-compartment model is not uniquely identifiable, what about the 
commonly used two-compartment model shown as follows: 
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Model 2. The two-compartment model with no loss from compartment 2. 
 
 
In this case, there is no k(0,2). Thus k(2,2)=k(1,2) making k(1,2) uniquely identifiable. 
Since the produce k(1,2)k(2,1) is identifiable and k(1,2) is known, one can solve for 
k(2,1) making it uniquely identifiable. Since k(1,1)=k(0,1)+k(2,1), and k(2,1) is known, 
one can solve for k(0,1) making it uniquely identifiable. Thus the parameters for the two-
compartment model, Model 2, are uniquely identifiable, and can be obtained directly 
from the coefficients A1 and A2 and exponentials a1 and a2 of the sum of two exponentials 
using (3). 
 
In what follows, initial parameter estimates for Model 2 will be discussed for the bolus 
and constant infusion inputs. 
 
Part 1. Bolus injection into plasma 
 
Three methods to estimate k(2,1), k(1,2), k(0,1) and vol will be given. The formal curve 
peeling method, as discussed in [1], will be given first. This is somewhat tedious, so two 
quicker methods will be discussed. If neither of these quicker methods work, you can 
always rely on the formal curve peeling method. 
 
If you plot the theophylline data in semi-log form, you will obtain the following: 
 

 
 
The left plot shows the totality of the data (the Plot/Table Scale has been set with a 
maximum of 370 for the X Axis, and the Y Axis going from 1.5 to 25). It is useful to 
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expand the initial portion of the plot to see some of the details of the start of the decay. 
You can clearly see the effect of the 5 minute infusion protocol rather than a bolus in this 
plot. 
 
 Curve Peeling
 
Following the description in Chapter 3 of [1], the first step in formal curve peeling is to 
draw a line through the final decaying portion of the data making sure this line is 
extended to intersect with the y-axis. This is shown in the following figure: 
 

 
 
Note the intersect of this line with the y-axis, as shown in the following figure, is 4.3. 
This provides an estimate for A2. You can now calculate the half-life of the terminal 
slope. This is shown in the following figure as the time it takes to go from 4 (at about 45 
minutes) to 2 (at about 410 minutes) which is approximately 365 minutes. The half-life is 
thus ln(2)/365, or 0.0019. This provides an estimate for a2. Thus we have the second 
term of (1): 
 
   (4) tta eeA ⋅−− ⋅=⋅ 0019.0

2 42
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The next step is to subtract this amount from each datum. The point is that s1(t) will 
describe each datum. Since s1(t) is a sum of two exponentials, both exponentials will 
contribute to the datum. Thus for the ith datum, . In formal curve 
peeling, the contribution of the second exponential, , is subtracted from each 
datum. For this example, the results are shown below: 

ii tata
i eAeAts 21

211 )( −− +=
taeA 2

2
−

 
t plasma plasma-4.3*exp(-0.0019*t)
5 15.5 11.24065658
6 13.8 9.548741645
7 11.8 7.556811367
10 9.45 5.230928742
15 6.43 2.250820135
20 5.87 1.730334354
30 4.85 0.788245502
45 4.24 0.292371485
60 3.84 0.00329079
90 3.66 0.035867234
120 3.4 -0.023334317
150 3.07 -0.163661294
180 2.95 -0.10449728
240 2.52 -0.2053995
300 2.54 0.108240614
360 2.2 0.030243341  

 
Again, remembering the model is: 
 
  (5) tata eAeAts 21

211 )( −− ⋅+⋅=
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the result of this subtraction is a set of modified data that can be described by the first 
exponential: 
 
  (6) taeAts 1

1
mod
1 )( −⋅=

 
That is, if you plot the modified data given in the previous table, the initial portion should 
decay monoexponentially. 
 
Why just the initial portion?  The reason is the term  decays rapidly and hence its 
contribution to the data in the tail portion of the curve is much, much less than . 
That is, in the tail portion of the curve, numerically  is much smaller than . 
Since  predominates in the tail portion, after a certain point you would expect the 
modified data to be near zero, and be both positive and negative. This is exactly the case 
as you can see in the previous table. 

taeA 1
1

−

taeA 2
2

−

taeA 1
1

− taeA 2
2

−

taeA 2
2

−

 
If you now plot the modified data, you will obtain the following: 
 

 
 
This plot is not informative since the initial decay is rapid. If the modified data are 
plotted in the 60 minute time scale, you will obtain the following: 
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Now you see the initial data do appear to decay monoexponentially although there is an 
indication there may be a break around 10 - 20 minutes. You can now repeat the above 
process to obtain estimates for A1 and a1. This is shown in the following figure: 
 

 
 
The intercept of the tangent line is at 20. This provides an estimate for A1. The half-life, 
here measured as the time to go from 10 to 5, is about 5 minutes. Thus an estimate for a1 
can be obtained from ln(2)/5 which is 0.14.  
  
If you are using (1) as your model, these will provide the initial estimates for the model 
parameters A1, A2, a1 and a2. If you are using Model 2, estimates for the rate constants 
and volumes can be found using (3): 
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0096.0)1,2(
21

2211)1,2()1,1()1,0(

106.0
)21()2,1(
)21(21)1,2(

0263.0
21

2112)2,1()2,2(

2

2

=−
+

⋅+⋅
=−=

=
+⋅
−⋅

=

=
+

⋅+⋅
==

k
AA

aAaAkkk

AAk
aaAAk

AA
aAaAkk

 (7) 

 
The dose is 1504000ng. Hence an estimate for vol can be obtained: 
 

 23.8
3.24

200
==vol  (8) 

 
If you put these initial estimates into your model and solve, you will obtain the following 
solution: 
 

 
 
These estimates are clearly satisfactory. 
 
 Quick Curve Peeling
 
There is a quicker method to obtain the initial parameter estimates that avoids the formal 
subtracting of  from the data.  taeA 2

2
−

 
The first step is to draw the line through the final decay, and estimate A2 and a2 as 
above; it will be exactly the same. Then, rather that subtracting this component from each 
datum, you can simply draw a tangent line through the initial decay. In this case, you can 
estimate the half-life but the intersect with the y-axis will be A1 + A2 instead of A1. 
Knowing A2, you can obtain an estimate for A1 simply by subtracting A2 from this 
intercept. 
 

©University of Washington Theo IV - 42 Rev. 08/10/13 



Pharmacokinetic Case Study Theophylline IV Kinetics 

To obtain better resolution for the estimates, you can operate on an expanded scale from 
0 to 120 (for example). Estimating A1 + A2 and the half-life are shown below: 
 

 
 
The intercept of 29 gives an estimate for A1 + A2. Knowing an estimate for A2 is 4.3, an 
estimate for A1 is 24.7 which is slightly higher than the estimate of 20 obtained above. 
The estimate of 0.0019 for a2 is obtained as described previously.  
 
From the above, you can see that the half-life of the initial decay is about 5 minutes. An 
estimate for a1 is thus ln(2)/5 or 0.14. The rate constants can be estimated: 
 

 

0115.0)1,2(
21

2211)1,2()1,1()1,0(

108.0
)21()2,1(
)21(21)1,2(

0224.0
21

2112)2,1()2,2(

2

2

=−
+

⋅+⋅
=−=

=
+⋅
−⋅

=

=
+

⋅+⋅
==

k
AA

aAaAkkk

AAk
aaAAk

AA
aAaAkk

 (9) 

 
and 
 

 7.6
29

200
==vol  (10) 

 
These estimates are a little different from the formal curve peeling method, but they are 
close enough to begin your modeling exercise. 
 
Technical remark: 
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There are many different kinds of biexponentially decaying data. They range from data 
whose initial decay is extremely rapid followed by a long, well-defined final decay, to 
data which display a very subtle biexponential nature. The subtle biexponential nature 
means it is difficult to be sure there is actually a second exponential in the data. At the 
extremes, one has to be aware that curve peeling, either formal or quick, may produce 
estimates for A1, A2, a1 and a2 that are very sensitive to how you draw your tangent 
lines. While you will produce estimates of these parameters, it could turn out that one of 
the k(i,j), especially k(0,1), may end up with a negative value. If this happens, you need to 
revisit your tangent lines, especially the one characterizing the initial decay. 
 
End of technical remark: 
 
 A Quick Method
 
There is a quick method that can be used that doesn’t involve curve peeling. However, it 
does not always produce satisfactory estimates, and you may have to resort to one of the 
two curve peeling methods. It also requires some experience in using the method since in 
many cases, you will have to adjust some of the parameters before proceeding with your 
modeling exercise. But it is quick, and provides insight into which model parameters 
affect different parts of the model predicted curve. 
 
The idea is the following. You can look for the time at which the break in the curve (data) 
occurs, and use the inverse of that number as initial estimates for all the k(i,j) of the two- 
compartment Model 2. 
 
If you look at the original data, reproduced in the following figure, you will see the break 
in the curve occurs at about 40 minutes. The reciprocal is 0.025, so you can use this value 
as the estimate for the rate constants.  
 

 
 
 
There are two different methods to estimate vol. One is the previous method where you 
can extrapolate the initial decay to time zero. The other is simply to use the first datum; 
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this assumes that the first datum is representative of the zero-time extrapolation. For the 
latter, remembering the dose is 200mg and the first datum is 15.5mg/L, an estimate for 
vol is 12.9. 
 
If you use these initial estimates and solve your model, you will obtain the solution 
shown in the following figure: 
 

 
 
While this does not appear very good, the initial decay does have the characteristics of 
the initial decay of the data. The initial decay is described pretty well. What is off is the 
final slope. You need to decrease k(0,1) from 0.025 to, for example, 0.01.  You will 
obtain: 
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Now things are getting closer, but the initial decay is not rapid enough (meaning k(2,1) is 
too small and needs to be increased) and the final decay is still too fast (meaning k(1,2) 
needs to be decreased). If you wish, you can experiment changing these values one 
parameter at a time. But the initial estimates now are sufficient to proceed with fitting 
your model to your data. 
 
When hand-fitting, as a rule of thumb it is a good idea to adjust one parameter at a time 
rather than in groups. In situations where the estimates are not very accurate, it is best to 
change them by a factor of no more than 5. As the estimates become better, it is best to 
change them by a factor of 2. This will allow you to watch the changes in the model 
solution, and make better estimates of the adjustments you need to make to the 
parameters. 
 
In summary, the steps to obtain the initial estimates for the two-compartment Model 2 
following a bolus injection are: 
 
 Formal curve peeling 
 
• Plot the data on semi-log paper. 
• Draw a straight line through the tail portion of the data; extend the line to intersect 

with the y-axis. 
• Calculate the half-life t1/2 as described above to obtain an estimate for a2 in (1). 
• Note where the line intersects the y-axis, this provides an estimate for A2 in (1). 
• Subtract  from each datum. taeA 2

2
−

• Plot the modified data on semi-log paper. 
• Draw a straight line through the initial decay extending is to the y-axis. Where it 

intersects the y-axis is an estimate for A1. 
• Calculate the half-life t1/2 as described above to obtain an estimate for a1 in (1). 
• Estimate the model parameters from (3). 
 
 Quick curve peeling 
 
• Plot the data on semi-log paper. 
• Draw a straight line through the tail portion of the data; extend the line to intersect 

with the y-axis. 
• Calculate the half-life t1/2 as described above to obtain an estimate for a2 in (1). 
• Note where the line intersects the y-axis, this provides an estimate for A2 in (1). 
• Draw a straight line through the initial decay extending is to the y-axis. Where it 

intersects the y-axis is an estimate for A1+A2. 
• Calculate the half-life t1/2 as described above to obtain an estimate for a1 in (1). 
• Calculate A1 by subtracting A2 from A1+A2. 
• Estimate the model parameters from (3). 
 

Quick method 
 
• Plot the data on semi-log paper. 

©University of Washington Theo IV - 46 Rev. 08/10/13 



Pharmacokinetic Case Study Theophylline IV Kinetics 

• Estimate the time at which the break in the data appears (the move from the 
dominance of one exponential to the second. 

• Calculate the reciprocal of this time. 
• Use this number as estimates for the rate constants k(2,1), k(1,2) and k(0,1). 
• Estimate the volume as the quotient of the bolus dose divided by the first datum or the 

initial tangent line decay value extrapolated to time zero.. 
 
To practice the method, you can try exercise 2 in Chapter 3 of [1]. 
 
Part 2. Constant infusion into plasma 
 
The case when the drug is administered as a constant infusion into a two-compartment 
model is not quite as straightforward as the bolus injection. First, the equation for a 
biexponential rise is 
 
  (11) 0)( 2102101

21 =++++= ⋅−⋅−
⋅ AAAeAeAAts tata

 
The counterpart of the curve peeling methods does not apply as described above without 
a preliminary step.  
 
Consider the following data (plotted in semilog and connected using the Line Plot option 
in the View menu) which were obtained following a constant infusion of 400,000 
units/minute for 310 minutes: 
 

 
 
These data are rising biexponentially to a plateau value. What happens if you subtract the 
plateau value from the data? You will obtain: 
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  (12) 
tatatata eAeAAeAeAAts ⋅−⋅−

⋅
⋅−⋅−

⋅ +=−++= 2121
210210

*
1 )(

 
since A0 is the plateau value. However, since there is the constraint equation A0 + A1 + A2 
= 0, this will be negative. But 
 
  (13) )()( 21

21
mod
1

tata eAeAts ⋅−⋅−
⋅ +−=

 
will decay biexponentially with a y-axis intercept of –(A1 + A2). This situation will now 
exactly parallel that of the biexponential decay! 
 
Using the data in the previous figure, he following figure illustrates what is: 
 

Intercept = 5300

 
 
For this set of data, a plateau value of 5300 is estimated as shown in the figure above. 
Subtracting this value from each datum, and multiplying the result by -1 gives the 
following set of modified data: 
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t plasma -(plasma-5300)
1 111 5189
2 264 5036
3 324 4976
4 391 4909
5 490 4810
6 569 4731
8 763 4537
10 879 4421
15 1210 4090
20 1377 3923
25 1728 3572
30 1815 3485
40 2238 3062
50 2613 2687
60 2829 2471
90 3366 1934
120 4015 1285
150 4446 854
180 4678 622
210 4850 450
240 5214 86
270 5463 -163
300 5319 -19  

 
If you plot the modified data, you will obtain the following figure.: 
 

 
 
It is interesting in that these data might appear to decay monoexponentially. This is an 
example of the more subtle biexponential decay discussed in the technical remark earlier 
in this appendix. In fact if you draw the tangent lines for the quick curve peeling method, 
you will see the biexponential as follows: 
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With these modified data, you can proceed to use either the formal or quick curve peeling 
methods to estimate the A1, A2, a1 and a2, and hence the rate constants of the model.  
 
For the volume vol, an estimate is obtained using the equation for the clearance rate CR 
as follows.  
 

 5.75
5300

400000
plateau

rateinfusion
===CR  (14)   

 
This is the same equation used in the monoexponential rise. With your estimate for 
k(0,1), 
 

 
)1,0(k

CRvol =  (15)   

 
 A Quick Method 
 
Is there a counterpart to the quick method?  The answer is yes, and it works as follows. 
You can estimate where the break in the rising data are (this is somewhat arbitrary); this 
is shown in the following figure: 
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break

 
 
As indicated in the figure, the break occurs at about 40 minutes. Estimates for the rate 
constants can be obtained from the inverse of 40 which is 0.025. An estimate for the 
volume can be obtained using the equation for clearance rate (14) as described above. 
Using 0.025 as an estimate for k(0,1) in (15), an estimate of 3020 for vol would be 
obtained. 
 
The following figure shows the simulation with k(0,1)=k(2,1)=k(1,2)=0.025 and vol 
equal 3020: 
 

 
 
Clearly these estimates are quite reasonable, and you can proceed with your modeling 
exercise. 
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In summary, the steps to obtain the initial estimates for the two-compartment Model 2 
following a constant infusion are: 
 
 Formal curve peeling or quick curve peeling 
 
• Plot the data on semi-log paper. 
• Draw a straight line to estimate the plateau value; extend the line to the y-axis to 

obtain an estimate for A0.  
• Subtract A0 from each datum, and multiply the result by -1. 
• Plot the modified data on semi-log paper, and proceed as above with either the formal 

or quick curve peeling method. 
• Plot the modified data on semi-log paper. 
 

Quick method 
 
• Plot the data on semi-log paper. 
• Draw a line to estimate the plateau (this will help in evaluating where the break 

occurs.) 
• Estimate the time at which the break in the data appears. 
• Calculate the reciprocal of this time. 
• Use this number as estimates for the rate constants k(2,1), k(1,2) and k(0,1). 
• Estimate the volume as the quotient of the clearance rate and k(0,1). 
 
 
 
1. Principles of Clinical Pharmacology. AJ Atkinson, Jr, CE Daniels, RL Dedrick, CV 

Grundzinskas and SP Markey, Eds. Academic Press. New York, NY, 2001. 
 
2. Cobelli, C, D Foster and G Toffolo. Tracer Kinetics in Biomedical Research. Kluwer 

Academic/Plenum Press, New York, NY, 2000. 
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Appendix 2:  The Runs Test for Goodness-of-Fit 
 
The runs test for the two-compartment and three-compartment models following the best-
fit of both models to the data is performed as described below. If you do not know how to 
perform or interpret the runs test, please consult any standard book on statistics or 
biostatistics. 
 
The two tables of weighted residuals are shown below. The left hand table are the 
weighted residuals from the best fit of the two-compartment model to the data; the right 
hand table are from the best fit of the three-compartment model. 
 

 
 
The tables were obtained as follows. Just before you Fit your model to your data: 
 

1. Set the Minimum Number of Calculation Intervals equal to “1”. 
 
2. Fit the model to the data. 

  
3. In the Show menu, click Table, or alternatively, on the SAAM II Toolbar, click 

Table . Assuming the Plot window is already open with a plot of the 
weighted residuals, the table shown above will appear. 

 
 

To perform the runs test, you must calculate the Z variable for each of the two fits. From 
the table, there are 16 weighted data points used in the “Fit”; thus for the runs test, N = 
16. 
 

Calculate the Z variable for the two-compartment model. 
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a. N, the number of data, is 16. 
 
b. The number of positive and negative residuals, n+ and n-, is respectively 7 and 

9. 
 
c. The number of runs R equals 5. (Remember a run is a sequence of positive or 

negative residuals; a run can consist of only one, or several, positive or 
negative residuals). 

 
d. Estimate the mean, variance and standard deviation from the formulas shown 

below: 
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e. Calculate the Z variable: 

 

 04.2−=−
=

σ
μRZ  

 
For a 5% significance level to see whether the “Fit” should be accepted or not, Z should 
be in the interval [-1.96,1.96]. Since it is not, the test for goodness-of-fit indicates that the 
“Fit” cannot be accepted. 
 

Calculate the Z variable for the three-compartment model. 
 

a. N, the number of data, is 16. 
 
b. The number of positive and negative residuals, n+ and n-, is respectively 9 and 

7. 
 
c. The number of runs R equals 9. (Remember a run is a sequence of positive or 

negative residuals; a run can consist of only one, or several, positive or 
negative residuals). 

 
d. Estimate the mean, variance and standard deviation from the formulas shown 

below: 
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e. Calculate the Z variable: 
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 06.0−=−
=

σ
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For a 5% significance level to see whether the “Fit” should be accepted or not, Z should 
be in the interval [-1.96,1.96]. Since it is, the test for goodness-of-fit indicates that the 
“Fit” can be accepted. 
 
As you saw in this case study, the AIC and BIC indicated that the three-compartment 
model was most appropriate. The test for goodness-of-fit confirms this conclusion. The 
important point to remember is that you should take advantage of all available 
information – parameter precision, results of the runs test and parsimony criteria - in 
making a final judgment. 
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Appendix 3: Contents of the Notes window for this Case Study 
 
Best fit of the two compartment model to the data 
 
   value SD  Coeff Var    95% Confidence 
V1                   10.53187  5.68684e-001  5.39965e+000       9.29281      11.77092 
k(0,1)                0.00847  7.19655e-004  8.49714e+000       0.00690       0.01004 
k(1,2)                0.03391  2.68275e-003  7.91116e+000       0.02807       0.03976 
k(2,1)                0.09954  1.01196e-002  1.01661e+001       0.07749       0.12159 
--------------------------------- Derived Variables --------------------------------- 
CLe                   0.08920  5.21059e-003  5.84157e+000       0.07785       0.10055 
CLi                   1.04836  6.47016e-002  6.17168e+000       0.90739       1.18934 
V2                   30.91513  1.42021e+000  4.59390e+000      27.82076      34.00950 
Vss                  41.44700  1.44750e+000  3.49241e+000      38.29317      44.60082 
 
 
                          Objective      Scaled Data Variance 
s1 : Plasma            -1.929837e+000       2.957864e-001 
                       -------------- 
Total objective        -1.929837e+000 
 
AIC                     2.665203e-001 
BIC                     3.872373e-001 
 
 
Best fit of a three compartment model to the data 
 
V1                    9.35622  6.14758e-001  6.57058e+000       7.98645      10.72599 
k(0,1)                0.00837  9.47258e-004  1.13140e+001       0.00626       0.01048 
k(1,2)                0.08196  2.84493e-002  3.47103e+001       0.01857       0.14535 
k(1,3)                0.01869  4.97213e-003  2.66055e+001       0.00761       0.02977 
k(2,1)                0.09310  1.89605e-002  2.03650e+001       0.05086       0.13535 
k(3,1)                0.05024  2.12474e-002  4.22957e+001       0.00289       0.09758 
--------------------------------- Derived Variables --------------------------------- 
CLe                   0.07833  6.44875e-003  8.23233e+000       0.06397       0.09270 
CLi                   0.87110  1.54672e-001  1.77561e+001       0.52646       1.21573 
CLi2                  0.47001  1.83550e-001  3.90521e+001       0.06104       0.87899 
V2                   10.62805  4.65224e+000  4.37733e+001       0.26219      20.99390 
V3                   25.15006  3.98684e+000  1.58522e+001      16.26683      34.03328 
Vss                  45.13432  2.19006e+000  4.85231e+000      40.25457      50.01407 
 
                          Objective      Scaled Data Variance 
s1 : Plasma            -2.856578e+000       1.405015e-001 
                       -------------- 
Total objective        -2.856578e+000 
 
AIC                    -7.185023e-002 
BIC                     9.715355e-002 
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